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Introduction 
PC_Link is a software package for use with GSM_Link and GSM Ultra_Link telemetry modules.  The installation 
and operation of these is described in the relevant Quick-Start manual, which also explains how they can be used with 
a mobile phone. 

PC_Link runs under Windows on any PC.  It uses one serial port, which needs to be connected to a GSM modem. Its 
functionality complements that of a mobile phone, so GSM_Link and GSM Ultra_Link outstations can be used with 
either PC_Link, a mobile phone or both. 

PC_Link has two parts: 

Configuration: PC_Link _Config automates the configuration task, compared with using a mobile phone.  It 
allows the user to create and manage multiple configurations. It also handles the upload and 
dowloading procedures to transfer the configurations to and from the outstations. 

Logger: PC_Link_Logger – allows the PC to retrieve data from GSM_Link and GSM Ultra_Link 
outstations.  The data can be interrogated manually using standard packages such as Word or 
Excel, or passed to third-party software packages for automatic processing. 

Installation 
PC_Link is normally supplied as a self-extracting file on a CD.  Navigate to the file named PC_Link Vx.zip and run 
it. Then follow the on-screen instructions. 

Install a GSM modem on a serial port of the PC and ensure that the relevant port is selected via the Comms/Setup 
menu.  Note that if using a laptop PC without a serial port it may be necessary to fit a USB-Serial adaptor.  In this case 
the adaptor software will allocate the first unused serial port.  To identify the port used right-click the My Computer 
icon on the desktop and select Properties. From the Device Manager tab select Ports and note the available COM 
devices. 

Note that the PC_Link _Config software may be used ‘off-line’ to compile, edit and save Configuration files without 
downloading them to the outstations.  This may be of use when there are multiple outstations to be configured and 
does not require the connection of a GSM modem. The configurations may then be downloaded at a later date or on a 
different PC when a GSM modem is available. 

PC_Link_Logger however requires a GSM modem for its operation, so if one is not attached to the host computer, the 
program will not run as desired. 

 

 

PC_Link_Logger is a licensed product – i.e. the user must purchase a licence from Churchill Controls for each copy 
of PC_Link_Logger that they wish to run. 

When the program starts up, it first checks the GSM modem and network coverage.  Once these have been verified, it 
then checks for the presence of a valid Licence Key File in the application folder where the software has been 
installed. 

Should this not be found or not be valid, the software Serial Number will be displayed and the user will be prompted 
to enter the Licence Key.  If this has not been supplied, the user should contact Churchill Controls to register the 
software and obtain the Licence Key.  The user will need to quote the Software Serial Number when doing this. 
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PC_Link_Config  
 

On starting the software, the user will be presented with the startup PC_Link_Config screen, which is effectively 
empty except for the menus at the top, and the modem status bar at the bottom. 

 

To open a configuration file, select the ‘File’ menu the choose ‘Open’.   The user will then be able to explore the PC 
and any attached network connections to find the desired configuration file.    All PC_Link_Config files have the 
‘.gsm’ extension. 

 

The following illustrations assume the user loads the Linton Reservoir example installed in the program folder by the 
installation software.  On opening the file the following screen will be displayed: 

 

 

 

The fields are defined as follows: 

 

Name: 
The name associated with the Outstation, which will be downloaded to the outstation on request. 

Location: 
A reference field where the user may enter information relevant to the outstation’s location.  It is not downloaded to 
the outstation. 
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Phone: 
The telephone number of the SIM within the GSM_Link outstation.  This must match the phone number of the SIM 
otherwise PC_Link will not be able to upload or download information to/from the outstation. 

Notes: 
A reference field allowing the user to enter text notes relevant to the outstation.  The contents of this field are not 
downloaded to the outstation. 

Power Supply: 
Indication of whether the outstation is intended to run on battery or mains power.  This information is not downloaded 
to the outstation – the selection of power supply is performed at the outstation using DIP switches, as detailed in the 
GSM_Link Quick Start manual. 

Outstation Scan Time: 
How often the GSM_Link outstation is required to scan for SMS messages. A value of zero in this field will cause the 
outstation to scan for SMS messages every 5 seconds, and is the preferred value for mains-powered outstations. 

Analogues: Sample Time: 
The interval at which the outstation will wake up, sample its analogue inputs and log the measured values internally.  

Analogues: Warning Sample Time: 
If any analogue level enter the first alarm band ( i.e. higher than the defined Hi Alarm level or lower than the defined 
Lo Alarm level ), the sample rate will change to the value specified here.  This allows a higher resolution of samples 
to be obtained in an first-level alarm event. 

Analogues: Alarm Sample Time: 
If any analogue level enter the second alarm band ( i.e. higher than the defined HiHi Alarm level or lower than the 
defined LoLo Alarm level ), the sample rate will change to the value specified here.  This allows a yet higher 
resolution of samples to be obtained in an second-level alarm event. 

Analogues: WarmUp Time: 
The delay in seconds between the GSM_Link outstation turning on its external 12V, and when the analogue reading is 
actually taken.   This number must be an even number – and odd numbers entered will be rounded up in the outstation. 

Dial-In 
The interval in minutes when the outstation will wake up and dial the basestation to download its logged data.  This 
requires the PC_Link_Logger software to be running in order for the data connection to the PC to be made. Entering a 
value of zero in this field will prevent the outstation from dialling in. 

Alarms: Log In Outstation 
Checking this box will cause the outstation to internally log any exception alarms which occur.  This event log is then 
retrieved when the outstation dials in to download its data. 

Alarms: Report to Basestation 
Checking this box will cause the outstation to dial into the basestation PC when any exception alarms occur. This 
requires the PC_Link_Logger software to be running in order for the data connection to the PC to be made.  

Alarms: Report to Mobile Phone 
Checking this box will cause the outstation to send an SMS to the required mobile phone when any exception alarms 
occur. The phone to which the messages are sent is the last one to send a message to the outstation.  See the 
GSM_Link Quick-Start manual for more information. 
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Clicking on the ‘Outstation Inputs’ tab will show the Digital, Analogue and Count inputs assigned and allow the user 
to edit their configuration. 

Clicking on any of the digital inputs will bring up its configuration information - as shown below for Digital 1: 

 

The Digital Input fields are defined as follows: 

Name: 
The name associated with the Digital Input.  This will be used when reporting to a mobile phone etc. 

Status when 0: 
Text describing the status of the input when it is not made – i.e. when it is 0. 

Status when 1: 
Text describing status of the input when it is made – i.e. when it is 1. 

Initiation Delay: 
The time – in seconds – for which the input must remain at a given state before it is registered by the outstation. 
This is to alleviate problems with ‘bouncy’ switches giving multiple transitions on inputs. 

Alarm: 
Checking this box allows the user to define exception reporting for any required transition of the relevant digital input. 
This exception will then be logged and/or reported to the basestation and/or mobile phone as detailed above. 
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Clicking on any of the analogue inputs will bring up its configuration information - as shown below for Analogue 1: 

 

The Analogue Input fields are defined as follows: 

Name: 
The name associated with the Analogue Input.  This will be used when reporting to a mobile phone etc. 

0% Level: 
The value required to be displayed when the input is at 0% of its scale. 

100% Level: 
The value required to be displayed when the input is at 100% of its scale. 

Units: 
The units required to be displayed for the measured value.  

Alarms: 
Four levels of alarm are available to generate exception reports of which any number may be utilised.  An exception 
report will be generated whenever the measured value crosses the boundary of the LoLo, Lo, Hi or HiHi alarms – 
whichever are selected. 

Hysteresis: 
This value allows the user to create a deadband around the alarm limits, to avoid constant alarms being generated if 
the measured value is hovering around one of the alarm limits. 
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Clicking on any of the count inputs will bring up its configuration information - as shown below for Count 1: 

 

The Count Input fields are defined as follows: 

Name: 
The name associated with the Count Input.  This will be used when reporting to a mobile phone etc. 

Counts Per Pulse: 
A scaling factor allowing the user to convert pulse counts into real-world units.  E.g. the value of 10 as shown will 
cause the measured value to go up by to for every pulse in. 

Units: 
The units required to be displayed for the measured value.  
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Clicking on the ‘Phone Numbers’ tab will show the defined Alarm phone numbers  

 

 

If the ‘Report To Mobile Phone’ option is chosen on the ‘General’ setting tab, then – when the outstation enters or 
exits an alarm condition – it will send an alarm message to a mobile phone. 

If there are no numbers defined in the list shown on this page – the message will default to the number of the mobile 
phone which last communicated with it. 

If however there are any number defined in this list, the outstation will send the alarm messages to all the defined 
numbers simultaneously. 
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Downloading the Data 
Once the user has completed the configuration, the file should be saved using the ‘File’ menu and ‘Save’ or 
‘Save As' as required. 

The data can then be downloaded to the outstation if required. 

This is done via a GSM Modem, which must be connected to a serial port of the host PC. 

(The communications settings for this can be configured by clicking on the ‘Comms’ menu and choosing 
‘Setup’) 

To download the configuration data to the outstation, click on the ‘Comms’ menu and choose the ‘Download 
to Outstation’ option. 

This will first run a short diagnostic check on the GSM modem to ensure it is set up correctly. 

When this passes, the download procedure will commence by sending a ‘BW:’ SMS message to the 
outstation.  This tells it to wake up, and dial into the basestation by to receive the data. 

The system will now wait for the outstation to dial in.  This time is dependant on the ‘SMS Scan Rate’ 
currently set within the outstation. 

Once the outstation dials in, the system will accept the call and download the configuration data. 

 

This process can be monitored in the ‘Modem Status’ window.  The user will be able to see all the comms. 
traffic between the PC, modem and outstation. 

Uploading Data 
PC_Link_Config also has the facility to upload data from an existing outstation for editing and saving on the 
host PC. 

To do this, the user should first click on the ‘File’ menu and select the ‘New’ option. 

This will create an empty config. ready to accept the uploaded data. 

The only field that the user must initially fill in is the ‘Phone’ field.  This must contain the phone number of 
the SIM card in the outstation from which data is to be uploaded. 

Once this is done, to upload the configuration data from the outstation, click on the ‘Comms’ menu and 
choose the ‘Upload Configuration from Outstation’ option. 

This will again run a short diagnostic check on the GSM modem to ensure it is set up correctly. 

When this passes, the upload procedure will commence by sending a ‘BW:’ SMS message to the outstation.  
This tells it to wake up, and dial into the basestation to upload the data. 

The system will now wait for the outstation to dial in.  This time is dependant on the ‘SMS Scan Rate’ 
currently set within the outstation. 

Once the outstation dials in, the system will accept the call and upload the configuration data. 

The user can monitor the progress in the ‘Modem Status’ window.  Here they will be able to see all the 
comms. traffic between the PC, modem and outstation. 

Once the upload has completed, the configuration file may be saved using the ‘File’ menu and ‘Save’ or ‘Save 
As' as required. 

If required the file may then be edited and downloaded back into the outstation. 

This method of editing the outstation configuration ensures that all the current configuration information is 
held on the host PC for reference if necessary – as opposed to editing the configuration via a mobile phone. 
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Configuring the Comms 
As previously mentioned, in order to Upload or Download data to/from an Outstation, the PC must be 
connected to a suitable GSM modem. 

 When an upload or download is initiated, the software will run a quick self-test on the GSM modem to ensure  
it is correctly configured and working. 

Should this fail, the user may need to alter some of the communications settings. 
 This is done by choosing the ‘Comms’ , ‘Setup’ menu.   The following screen will be shown : 

 

 

The settings are as follows : 

Comm. Port : This is the Serial Communications Port to which the GSM Modem is attached.  This can be 
changed to suit the configuration of the host PC. 

Baud Rate , Data Bits, Stop Bits, Parity : These must not be changed by the user. 

Comms Break Time : This is the maximum time allowed between characters in a data message before the 
system interprets the break as the end of transmission.  This setting may need to be lengthened depending on 
GSM network performance between basestation and outstation(s). 

Wait For Ready … : This check box is included for compatibility for older outstations.  It should be left 
unchecked if using a version of GSM_Link Firmware earlier than 1.0.4.  Versions later than this should have 
this box checked. 

 

Once the required Setup has been entered, clicking on ‘Apply’ will save the changes.  The user may then click 
on the ‘Run Self Test’ button to check whether the GSM Modem is working with the new settings. 



 

 

12

PC_Link_Logger  
 

PC_Link_Logger provides a means to monitor a number of GSM_Link outstations on a standard desktop PC. 

It allows the user to load outstation files previously configured using PC_Link_Config.  The software will then 
constantly monitor the GSM network for any of these configured outstations dialling-in.   

A simple display is shown for each outstation, along with the ability to log downloaded data and events, and a basic 
alarm-handling package for exception reports. 

 

On starting the software, a Self-Test will be run on the GSM Modem connected to the specified serial port of the host 
PC.  This checks the operation of the modem, as well as the GSM network coverage and available credit. 

Should this fail, the user can adjust certain communication settings.  The method for this is identical to that explained 
in the ‘Configuring the Comms’ chapter of the PC_Link_Config section above. 

Once this is done, the software will check for a valid Licence Key.  This is explained in the ‘Installation’ section at the 
front of this manual.  

If this is not found, the software will continue to run, but in Demo Mode only.  Here the user is limited to monitoring 
one outstation and all logging of data is disabled.  To enter a licence key at a later date, select the ‘Licence Key’ entry 
from the ‘Help’ menu. 

 

The user will be asked if they wish to resume a previous session.  This is to allow the system to resume from a power 
down without the need to re-enter all the setup and configuration data. 

  

Monitoring Outstations 
In order to begin monitoring outstations, the user must load the desired outstation configurations into 
PC_Link_Logger. 

The ‘Outstation’, ‘Add’ menu allows the user to open a previously defined PC_Link configuration file (*.gsm). Once 
opened, the outstation will be added into the list in the main grid.  

Once an outstation is loaded, it will begin being monitored for incoming data.  No outstation is monitored until its 
configuration file has been loaded in this way. 

 

To close an Outstation file, choose the ‘Outstation’, ‘Remove’ menu.  This will prompt the user to double-click on the 
outstation they wish to remove. This will remove the Outstation from the system and stop it being monitored. 
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Adding a New Outstation 
When adding a new ( or the first ) outstation onto the system, there is a recommended order for the procedure to 
ensure that the GSM_Link Outstation and the PC_Link basestation software synchronise correctly. 

Compile Configuration File 
Using PC_Link_Config, define the configuration for the new outstation and save it on the host PC. 

Download Configuration to Outstation 
Using PC_Link_Config, donload the configuration to the new outstation.   Then exit out of PC_Link_Config  

Load the new Outstation in PC_Link_Logger 
Startup PC_Link_Logger.  Using the ‘File’, ‘Open’ menu, load the ‘.gsm.’ configuration file into PC_Link_Logger.  
The system will now be ready to communicate with the new outstation. 

Switch On the Outstation 
Power-up the outstation. If this is a new outstation, it will now monitor SMS messages and will await communication 
from the PC basestation. 

Start communication with the Outstation 
Double-click on the outstation to be started.  This will bring up a window with a dropdown box to select the amount of 
data to be retrieved. 

 

Select the ‘No Data – just set times’ option.  The click on the ‘Force Call’ button.  This will then send an SMS 
message to the outstation to wake up.  When it receives this message it will dial into the basestation and the software 
will answer the call.  The two will communicate and the software will set up all the dial-in times for the outstation.  
The call will then terminate, and the row in the grid corresponding to the outstation will be updated. 

The outstation will then be ready to dial-in as required to download its logged data. 

 

Force Download 
If the user requires an immediate download of the outstation data log, they may click on this button.  This will send an 
SMS message to the outstation, which will then dial-in for the basestation to download the data. Again, note that the 
response time to this command depends on how often the outstation is checking for SMS messages. 

Show Config File 
Clicking this button will show the raw ‘.gsm’ file associated with the outstation.  It can be decoded by Churchill, but it 
is more sensible to view this file through PC_Link_Logger. 
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Logging Data 
 

As part of the Outstation configuration, each outstation may be required to dial-in at a defined interval. 

When this happens, PC_Link_Logger will download logged data and events, storing them in a file or database 
allowing retrieval by a third party Scada or analysis program. 

Choosing the ‘Logging’, ‘Setup’ menu allows the user to configure the logging as desired. 

The user may choose between logging data in a ‘.csv’ ( comma-separated-variable ) file, suitable for import into 
spreadsheets such as Excel, or choose ‘Broadwin’ file format suitable for import by the Broadwin Scada systems. 

‘csv’ logging 
If the user selects this option, they must then choose the destination folder that the files will be logged into. 

PC_Link_Logger will create separate files for each outstation each day.  The format of the filenames for these is : 

  OutstationName_ddmmyy.csv   ( e.g.  Linton Reservoir_01Oct04.csv ) 

If the outstation has been configured to log digital events, these will be recorded in a file with the ‘.evt. extension. 

The Excel screenshot below shows the file created from the outstation “Maretimo” which has one analogue input used 
(also named Maretimo). 
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‘Broadwin’ logging 
The Broadwin Scada system expects files of a specific format to be created. 

In order to do this, PC_Logger has to use a database in a temporary folder, before copying the final files into the 
required destination folder. 

Choosing the ‘Logging’, ‘Setup’ menu allows the user to configure the paths of both the temporary and the destination 
folders. 

Note that for the Broadwin files to be created successfully, the destination folder must contain the database named 
‘Broadwin.mdb’.   This database has a specific structure and will be supplied with the PC_Link_Logger application. 

 

The Broadwin WebAccess historical file format is described below: 
 
For each measured value (Measurand), 4 files are to be created. 

These are binary files, not ascii. 
 

� 1 x Daily file – File name is Measurand$YYYYD.DAT, where YYYY is the 4 digit year, such as 2005, and D is 
the letter D 

� 1 x Hourly File – File name is Measurand$YYYYMMH.DAT, where YYYY is the 4 digit year, MM is the month 
and H is the letter H. 

� 1 x Minute File – File name is Measurand$YYYYMMM.DAT, where YYYY is the 4 digit year, MM is the month 
and M is the letter M. 

� 1 x Second File - File name is Measurand$YYYYMMDDX.DAT, where YYYY is the 4 digit year, MM is the 
month. DD is the day and X is the letter X 

 
 
Daily, Hourly and Minute files are similar. 
 
The daily file contains 1 record for each day in the year 
 
The hourly file contains 1 record for each hour in the month 
 
The minute file contains 1 record for each minute in the month. 
 
A record consists of  

� Time_t time 4 bytes Seconds since 1/1/1970 

� Unsigned short Status 2 bytes Set to zero always 

� Float last 4 bytes Last value in the time period 

� Float max 4 bytes Max value in the time period 

� Float min 4 bytes Minimum value in the time period 

� Float avg 4 bytes Average value in the time period 

 
 
So, for the daily file, there will be one entry for each day, giving the last value for that day, the maximum for that day, 
the minimum for that day and the average for that day. 
 
 



 

 

16

 
Similarly for the hourly file, there will be one entry for each hour, giving the last value for that hour, the maximum for 
that hour, the minimum for that hour and the average for that hour. 
 
For the minute files, the last, min, max and average values will be identical, as the data doesn’t change that fast. 
 
Note that the Broadwin software operates in Pacific Time, so PC_Link adds 28800 (8 hours in seconds) to each time 
before writing to the file. 
 
 
The format for the Second file is slightly different, in that there is no last, min, max or average, just the data. 
 
A record consists of  

� Time_t time 4 bytes Seconds since 1/1/1970 

� Unsigned short Status 2 bytes Set to zero always 

� Float data 4 bytes Data in this second 
 

The Second file only contains data when the values change, so you will only need to have a small number of records 
for each day (96), with the appropriate timestamp. Again, PC_Link adds  28800 to each time before writing. 

 

When downloaded data comes into PC_Link_Logger, it adds all data into a table in the ‘Broadwin.mdb’ database.  No 
processing is done on the data until the download process is complete and the call has hung up. 

Once this is done, the software parses through the database , filtering the data and creating the files as described 
above. 

These are created in the specified temporary folder (directory) at first. 

Subsequently, all completed files are copied into the destination folder.  This is the folder that the Broadwin software 
is looking at and it is from here that it will import the downloaded data. 
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Alarms – ( note that this functionality is currently disabled ) 
 

As part of the Outstation configuration, each outstation may be required to dial-in on exception (alarm). 
When this happens, PC_Link_Logger can log and/or display these alarms on an alarm banner. 

If the user wishes to use this feature, the database file ‘Alarms.mdb’ must be installed in the same folder as 
PC_Link_Logger was installed. 

If ‘Log Alarms’ has been selected from the ‘Logging’ menu then an alarm banner will be shown.  
This may be positioned on the screen as required by the user. 

 

 

When outstations dial-in with exceptions, these are added to the alarm banner. 

New alarms will be shown in red, flash and sound the system ‘beep’ until they are accepted. 

To accept an alarm, the user can click on the relevant alarm line on the banner.  A screen will then be shown with 
details of the alarm and allow the user to enter a name / code for accepting the alarm. 

 

Once accepted, alarms will show in yellow. 

The user may then set the Alarm as ‘Cleared’ by again clicking on the alarm within the banner and clicking on ‘Clear 
Alarm’ on the details form. 

Once cleared, the alarm will stay as green until it is deliberately removed from the banner – again by clicking on it and 
clicking on ‘Remove Alarm from Event Log’ on the details form. 
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Alarm History 
In addition to showing Alarms in real time on the alarm banner, PC_Link_Logger also logs alarms to a database for 
subsequent retrieval and analysis. 

Choosing the ‘Logging’, ‘Alarm History’ menu option will bring up the following screen :  

 

This shows the history of exception report received by the basestation. 

The history is initially sorted in date order, with the oldest alarms appearing first.  However by selecting other entries 
in the ‘Sorted by’ list, the history may be presented sorted by Outstation or Alarm Event also. 

The user may also filter the results to only show Alarm events containing a certain text string.  For example, if the user 
typed “Jim” in the ‘Search for:’ window and clicked ‘Go’, only the second Alarm in the above list would be shown – 
as it was accepted by Jim.  To return to the full list, choose an option from the ‘Sorted by:’ list. 

 

Clicking on any History item will bring up the details screen for that alarm, in a similar way to the Current Alarm 
described above. 

The user then has the option of permanently removing the Alarm event from the history if required. 


